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Creating a public 
realm proposal using 
Illustrator
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What is a Public Realm Proposal?

A public realm proposal primarily consists of the 
roadways, sidewalks, parks, plazas, and other open 
spaces that comprise the arteries and focal points of 
the urban framework. It is the main space where civic 
interaction occurs and is often defined in contrast to 
private property.

It may include: 

• Plan representations 

• Bird’s eye into specific areas 

Graphic for Guide to Placemaking for Mobility. Source: Stantec.

Public Realm Action Plan. Source: Chattanooga Design Studio

Rethinking roundabout designs with green infrastructure. 
Images Sourced from Eric Hallquist, Director of Landscape Architecture, Aecom
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Pop up Green Streets, Via Porpora. Source: Quinzii Terna Architecture
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Where to start to design a Public Realm Proposal?
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Urban playground

Mid-block crosswalk and greenery

1.  Digimap plan 2.  Digimap plan personalised with 
different colours and patterns 3.  Public realm proposal

Thurrock Theatre – 
façade renovation

Enlargement of the pedestrian 
and cycle lane + street trees 

New foyer and café spillover at 
the entrance of the theatre

Raised pavement to prioritise 
pedestrian footfall
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Open a digimap map and make it editable in Illustrator by 
realising clipping masks  

Very often a PDF image (or any kind of vector-based image) is composed of

different layers and/or overlapped images. If you want to

modify/erase/separate one of those layers, firstly you should unlock it by

releasing any clipping mask. To do this:

Once you open a PDF image (or any kind of vector-based image) in 

Illustrator, you should left-click on the element you want to release (it 

seems that nothing is selected by this point), such as a text or a line, then 

right-click on it and press ‘releasing clipping mask’.
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Once you release the first clipping mask (right-click), then you should deselect (or click on the grey

background). When everything is deselected, then you should select with the cursor something on the map

that has not been released. Once it is selected, then you right-click on it and again 'release clipping mask'.

If everything is released, by right-clicking you will not find anymore the tool 'release clipping mask'.

PS. you can do this only i) before modifying the image in PSD and ii) if it originally is a PDF image (or any 

kind of vector-based image).

A step-by-step tutorial is also available in the BSP Graphic Skills Portal – Adobe Illustrator handout

PPS. sometimes you need to 'ungroup' the image before starting realising clipping masks. To do this, right-

click on the image and press 'ungroup', then click on the grey background and, when everything is

deselected, start with the 'release clipping mask' process.
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When you are in this situation, it means you still have to

realise some clipping mask. You can understand this if:

• The green areas’ colour (green) appears only inside the

boundary of the frame – it means you should realise the

gardens/parks, etc.

• The buildings’ colour (orange) appears only inside the

boundary of the frame – it means you should realise the

building layer.

• The streets’ colour (grey) appears only inside the boundary

of the frame – it means you should realise the streets/plots,

etc. layer.

• Etc.
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5
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When everything is realised, you will see that objects

are spanned outside of the paper artboard, as well as,

you will be able to select everything.
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Select similar objects

Now, you may want to separate different layers via 

selecting similar objects: 

1. Click once on the fill colour of a building (NB. you can

check that the selection is right when the fill colour is 

orange in the left-side bar).

2. Choose Window > Select similar objects, and choose a 

preset from the Preset drop-down menu.

1

2
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Select similar objects

Now, you may want to separate different layers via 

selecting similar objects: 

1. Click once on the fill colour of a building (NB. you can

check that the selection is right when the fill colour is 

orange in the left-side bar).

2. Choose Window > Select similar objects, and choose a 

preset from the Preset drop-down menu.

1
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Create a separate layer

Now, all the buildings are selected. To ‘separate’ 

them from the other objects, and move them to a 

different layer: 

1. Edit > Cut 

2. Before pasting, go on the right-sidebar > open layers 

3. On the bottom, click on ‘+’ to create a new layer

4. Rename it as ‘Buildings’ 

4
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Create a separate layer

Now, all the buildings are selected. To ‘separate’ 

them from the other objects, and move them to a 

different layer: 

1. Edit > Cut 

2. Before pasting, go on the right-sidebar > open layers 
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Create a separate layer

Once you have created the layer ‘Building’: 

1. Select the new layer created 

2. Edit > paste in place

3. Now, all the buildings on your map are on a separate 

layer. To change colour, select all the object on that layer 

at once by clicking the small dot close to the layer’s

name. 

4. Change colours to all the selected buildings by using the 

left-sidebar: double-click on the fill colour > pick the 

black colour > ok 

3

4

3
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Setting the background of your map

Once you separated and organised the layers...

3
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Once you release the first clipping mask (right-click), then you should deselect (or click on the grey

background). When everything is deselected, then you should select with the cursor something on the map

that has not been released. Once it is selected, then you right-click on it and again 'release clipping mask'.

If everything is released, by right-clicking you will not find anymore the tool 'release clipping mask'.

PS. you can do this only i) before modifying the image in PSD and ii) if it originally is a PDF image (or any 

kind of vector-based image).

A step-by-step tutorial is also available in the BSP Graphic Skills Portal – Adobe Illustrator handout

PPS. sometimes you need to 'ungroup' the image before starting realising clipping masks. To do this, right-

click on the image and press 'ungroup', then click on the grey background and, when everything is

deselected, start with the 'release clipping mask' process.

You can change colours and add patterns. Here are the 
combinations used in the image on the right: 

Buildings: Solid colour – white fill & black stroke (0.75 pt)

Parking: Solid colour – ligh rose fill & gray stroke (0.20 pt)

Green areas: Solid colour 

Plots: Solid colour

Roads: Dotted pattern



13Technique Handouts     B S P  G R A P H I C  S K I L L S  P O RTA L    |

How to add pattern to a layer? 

1. Select the layer you want to add the pattern

2. Open the fill coulour drop down menu

3. Open the Swatch Library menu

4. Patterns 

5. Basic Graphics 

6. Basic Graphics_Textures

3
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Once you release the first clipping mask (right-click), then you should deselect (or click on the grey

background). When everything is deselected, then you should select with the cursor something on the map

that has not been released. Once it is selected, then you right-click on it and again 'release clipping mask'.

If everything is released, by right-clicking you will not find anymore the tool 'release clipping mask'.

PS. you can do this only i) before modifying the image in PSD and ii) if it originally is a PDF image (or any 

kind of vector-based image).

A step-by-step tutorial is also available in the BSP Graphic Skills Portal – Adobe Illustrator handout

PPS. sometimes you need to 'ungroup' the image before starting realising clipping masks. To do this, right-

click on the image and press 'ungroup', then click on the grey background and, when everything is

deselected, start with the 'release clipping mask' process.

2.

3.

4.
5.

6.
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1. Choose the Texture most appropriate for 
the layer. 

Note. you can asjust the scale and direction 
of the texture by: 

2. Select and right-click on the layer with the 
texture

3. Transform > Scale 

4. Deselect ‘Transform Objects’ and adjust 
the scale 

3
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Once you release the first clipping mask (right-click), then you should deselect (or click on the grey

background). When everything is deselected, then you should select with the cursor something on the map

that has not been released. Once it is selected, then you right-click on it and again 'release clipping mask'.

If everything is released, by right-clicking you will not find anymore the tool 'release clipping mask'.

PS. you can do this only i) before modifying the image in PSD and ii) if it originally is a PDF image (or any 

kind of vector-based image).

A step-by-step tutorial is also available in the BSP Graphic Skills Portal – Adobe Illustrator handout

PPS. sometimes you need to 'ungroup' the image before starting realising clipping masks. To do this, right-

click on the image and press 'ungroup', then click on the grey background and, when everything is

deselected, start with the 'release clipping mask' process.

1.

3.
4.
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To design the public realm on the plan, the best thing is to 
identify some areas that you may want to develop. 

3
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Once you release the first clipping mask (right-click), then you should deselect (or click on the grey

background). When everything is deselected, then you should select with the cursor something on the map

that has not been released. Once it is selected, then you right-click on it and again 'release clipping mask'.

If everything is released, by right-clicking you will not find anymore the tool 'release clipping mask'.

PS. you can do this only i) before modifying the image in PSD and ii) if it originally is a PDF image (or any 

kind of vector-based image).

A step-by-step tutorial is also available in the BSP Graphic Skills Portal – Adobe Illustrator handout

PPS. sometimes you need to 'ungroup' the image before starting realising clipping masks. To do this, right-

click on the image and press 'ungroup', then click on the grey background and, when everything is

deselected, start with the 'release clipping mask' process.

Let’s start design the public realm

URBAN PLAYGROUND

PUBLIC SQUARE

MID-BLOCK CROSSWALK AND GREENERY
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Setting the background of your map

Then, it is always useful to identify some elements or 
groups of elements which are part of your strategy. 
For instance, 

Add greenery

Add street crossing

Add public areas

Add street protections 

Add urban furniture 

etc. 

3
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Once you release the first clipping mask (right-click), then you should deselect (or click on the grey

background). When everything is deselected, then you should select with the cursor something on the map

that has not been released. Once it is selected, then you right-click on it and again 'release clipping mask'.

If everything is released, by right-clicking you will not find anymore the tool 'release clipping mask'.

PS. you can do this only i) before modifying the image in PSD and ii) if it originally is a PDF image (or any 

kind of vector-based image).

A step-by-step tutorial is also available in the BSP Graphic Skills Portal – Adobe Illustrator handout

PPS. sometimes you need to 'ungroup' the image before starting realising clipping masks. To do this, right-

click on the image and press 'ungroup', then click on the grey background and, when everything is

deselected, start with the 'release clipping mask' process.

https://www.chattanoogastudio.com/publicrealmactionplan
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Start working on each site

Once the background image is set, it is possible to 
start designing the public realm for each site. 

In SITE 1 you can create:

3
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Once you release the first clipping mask (right-click), then you should deselect (or click on the grey

background). When everything is deselected, then you should select with the cursor something on the map

that has not been released. Once it is selected, then you right-click on it and again 'release clipping mask'.

If everything is released, by right-clicking you will not find anymore the tool 'release clipping mask'.

PS. you can do this only i) before modifying the image in PSD and ii) if it originally is a PDF image (or any 

kind of vector-based image).

A step-by-step tutorial is also available in the BSP Graphic Skills Portal – Adobe Illustrator handout

PPS. sometimes you need to 'ungroup' the image before starting realising clipping masks. To do this, right-

click on the image and press 'ungroup', then click on the grey background and, when everything is

deselected, start with the 'release clipping mask' process.

• Simple banches and sittings

• Some gazebos - you can do this by 
creating a hexagon and play with colour 
tones

• Simple bicycle rack - you can do this 
using multiple rectangular shapes

• Parking spaces

• Different tree typologies - Adobe 
Stock has multiple options:     
https://stock.adobe.com/search?k=tree+plan

PUBLIC SQUARE
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Start working on each site

Moreover, identifying different pavement patterns 
is useful to define different urban spaces. For 
squares for example, you can use the Pen tool to 
define the area using a white fill and a transparent 
stroke. 

Then, this layer should be duplicate by Edit > Copy, 
Edit > Paste in Place. On the duplicate on top, let’s 
add a texture by

1. Select the layer you want to add the pattern

2. Open the fill coulour drop down menu

3. Open the Swatch Library menu

4. Patterns 

5. Basic Graphics 

6. Basic Graphics_Textures
3
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Once you release the first clipping mask (right-click), then you should deselect (or click on the grey

background). When everything is deselected, then you should select with the cursor something on the map

that has not been released. Once it is selected, then you right-click on it and again 'release clipping mask'.

If everything is released, by right-clicking you will not find anymore the tool 'release clipping mask'.

PS. you can do this only i) before modifying the image in PSD and ii) if it originally is a PDF image (or any 

kind of vector-based image).

A step-by-step tutorial is also available in the BSP Graphic Skills Portal – Adobe Illustrator handout

PPS. sometimes you need to 'ungroup' the image before starting realising clipping masks. To do this, right-

click on the image and press 'ungroup', then click on the grey background and, when everything is

deselected, start with the 'release clipping mask' process.

2.

3.

4.
5.

6.
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Start working on each site

In SITE 2 you can create:

3
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Once you release the first clipping mask (right-click), then you should deselect (or click on the grey

background). When everything is deselected, then you should select with the cursor something on the map

that has not been released. Once it is selected, then you right-click on it and again 'release clipping mask'.

If everything is released, by right-clicking you will not find anymore the tool 'release clipping mask'.

PS. you can do this only i) before modifying the image in PSD and ii) if it originally is a PDF image (or any 

kind of vector-based image).

A step-by-step tutorial is also available in the BSP Graphic Skills Portal – Adobe Illustrator handout

PPS. sometimes you need to 'ungroup' the image before starting realising clipping masks. To do this, right-

click on the image and press 'ungroup', then click on the grey background and, when everything is

deselected, start with the 'release clipping mask' process.

• Simple banches and sittings

• Zebra crossing - you can do this using 
multiple rectangular shapes with white fill 
and black stroke. 

• Different tree typologies -
 Adobe Stock has multiple options:     
https://stock.adobe.com/search?k=tree+plan

NOTE. you can add transparency to some 
of those thees.

• Some plays for kids. Those can be 
designed by downloading some ready-
made and available online or using some 
shapes and colours.

• Some hillocks / terrain movements 
to simulate level changes. Those can 
be designed using the Curvature Tool and 
adding different colours.

URBAN PLAYGROUND
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Start working on each site

In SITE 3 you can add:

3
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Once you release the first clipping mask (right-click), then you should deselect (or click on the grey

background). When everything is deselected, then you should select with the cursor something on the map

that has not been released. Once it is selected, then you right-click on it and again 'release clipping mask'.

If everything is released, by right-clicking you will not find anymore the tool 'release clipping mask'.

PS. you can do this only i) before modifying the image in PSD and ii) if it originally is a PDF image (or any 

kind of vector-based image).

A step-by-step tutorial is also available in the BSP Graphic Skills Portal – Adobe Illustrator handout

PPS. sometimes you need to 'ungroup' the image before starting realising clipping masks. To do this, right-

click on the image and press 'ungroup', then click on the grey background and, when everything is

deselected, start with the 'release clipping mask' process.

• Zebra crossing - you can do this using multiple 
rectangular shapes with white fill and black stroke 
- with a mid-block crosswalk created using 
a rectangular shape (yellow fill and blck 
stroke). 

MID-BLOCK CROSSWALK AND GREENERY

Using the Pen Tool, add two new points 
in the midpoint of the short length of the 
rectangle.

Use the Direct select Tool (white arrow) > 
click in one of those points > move outside



21Technique Handouts     B S P  G R A P H I C  S K I L L S  P O RTA L    |

• To the crosswalk you can also add some other 
elements, such as light poles or traffic lights 
for crossing

• New green areas

• Different tree typologies -  Adobe Stock has multiple 
options:     
https://stock.adobe.com/search?k=tree+plan

NOTE. you can add transparency to some of those thees.

• Some flowerpots to protect pedestrians from 
vehicles. To design those you can:

1. Create a rectangle 

2. Create a smaller rectangle inside 

3. Copy a tree in-between the two rectangles 

4. Select the small rectagle (on top) and the 
tree (below) > right-click > Make clipping 
mask

Start working on each site

3
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Once you release the first clipping mask (right-click), then you should deselect (or click on the grey

background). When everything is deselected, then you should select with the cursor something on the map

that has not been released. Once it is selected, then you right-click on it and again 'release clipping mask'.

If everything is released, by right-clicking you will not find anymore the tool 'release clipping mask'.

PS. you can do this only i) before modifying the image in PSD and ii) if it originally is a PDF image (or any 

kind of vector-based image).

A step-by-step tutorial is also available in the BSP Graphic Skills Portal – Adobe Illustrator handout

PPS. sometimes you need to 'ungroup' the image before starting realising clipping masks. To do this, right-

click on the image and press 'ungroup', then click on the grey background and, when everything is

deselected, start with the 'release clipping mask' process.
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Now the public realm is developed for three sites. Those can 
be increased with greenery, curb extensions, wayfindings 
etc. 

3
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Once you release the first clipping mask (right-click), then you should deselect (or click on the grey

background). When everything is deselected, then you should select with the cursor something on the map

that has not been released. Once it is selected, then you right-click on it and again 'release clipping mask'.

If everything is released, by right-clicking you will not find anymore the tool 'release clipping mask'.

PS. you can do this only i) before modifying the image in PSD and ii) if it originally is a PDF image (or any 

kind of vector-based image).

A step-by-step tutorial is also available in the BSP Graphic Skills Portal – Adobe Illustrator handout

PPS. sometimes you need to 'ungroup' the image before starting realising clipping masks. To do this, right-

click on the image and press 'ungroup', then click on the grey background and, when everything is

deselected, start with the 'release clipping mask' process.

Let’s start design the public realm
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As explained at the beginning, the map is often 
accompanied by some bird’s eye zooms for the most 
developed sites. You can create those by using some 
exemplar images.

3
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Once you release the first clipping mask (right-click), then you should deselect (or click on the grey

background). When everything is deselected, then you should select with the cursor something on the map

that has not been released. Once it is selected, then you right-click on it and again 'release clipping mask'.

If everything is released, by right-clicking you will not find anymore the tool 'release clipping mask'.

PS. you can do this only i) before modifying the image in PSD and ii) if it originally is a PDF image (or any 

kind of vector-based image).

A step-by-step tutorial is also available in the BSP Graphic Skills Portal – Adobe Illustrator handout

PPS. sometimes you need to 'ungroup' the image before starting realising clipping masks. To do this, right-

click on the image and press 'ungroup', then click on the grey background and, when everything is

deselected, start with the 'release clipping mask' process.

Let’s start design the public realm
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Thurrock Theatre – 
façade renovation

Enlargement of the pedestrian 
and cycle lane + street trees 

New foyer and café spillover at 
the entrance of the theatre

Raised pavement to prioritise 
pedestrian footfall
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Instead of using exemplar images, you can also create 
some ‘3D pieces’ of you plan by using SketchUp for 
Web.

3
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Once you release the first clipping mask (right-click), then you should deselect (or click on the grey

background). When everything is deselected, then you should select with the cursor something on the map

that has not been released. Once it is selected, then you right-click on it and again 'release clipping mask'.

If everything is released, by right-clicking you will not find anymore the tool 'release clipping mask'.

PS. you can do this only i) before modifying the image in PSD and ii) if it originally is a PDF image (or any 

kind of vector-based image).

A step-by-step tutorial is also available in the BSP Graphic Skills Portal – Adobe Illustrator handout

PPS. sometimes you need to 'ungroup' the image before starting realising clipping masks. To do this, right-

click on the image and press 'ungroup', then click on the grey background and, when everything is

deselected, start with the 'release clipping mask' process.

Combine a public realm plan with 3D

SketchUp is a modelling software to create 3D graphics that can be 
used for creating a 3D model, sections or aerial views. 

In SketchUp, you can:

• Create 3D models of buildings, furniture, interiors, landscapes, 
and more.

• Customize the SketchUp interface to reflect the way you work.

• Share 3D models as walk through animations, scenes, or printouts, 
with realistic light and shadows. You can even print a model on a 
3D printer.

• Import files from other 3D modelling programs or tools, or 
export your SketchUp file for use with other popular modelling 
and image-editing software.

Key skills:

• Making 3D objects 

• Adding textures and shadows

• 3D Warehouse 

• Setting scenes and styles

• Parallel vs. Perspective views

Downloading: 

1. Using the FREE version SketchUp for Web (https://www.sketchup.
com/products/sketchup-for-web). 

In this case, you do not have to download anything, but your 
project will stay online: The first time you use SketchUp, you need 
to sign in to activate your free version. After you’re signed in, just 
click on “start modelling”. This dialogue box is your starting point 
for creating a model and appears every time you start SketchUp 
(unless you choose to turn it off in the SketchUp Preferences 
dialogue box).

HAVE A LOOK TO THE RELATED PORTAL HANDOUTS:

SOFTWARE GUIDE: https://www.ucl.ac.uk/bartlett/planning/sites/
bartlett_planning/files/sketchup.pdf

TECHNIQUES: 
• https://www.ucl.ac.uk/bartlett/planning/sites/bartlett_planning/

files/3.1_techniques_handouts_sketchup_to_photoshop-perspective.pdf

• https://mediacentral.ucl.ac.uk/Player/IIE7JFa2
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This is an example on how you can turn the previous 
exemplar images into proper 3D views. 

3

AAddoobbee  IIlllluussttrraattoorr

Once you release the first clipping mask (right-click), then you should deselect (or click on the grey

background). When everything is deselected, then you should select with the cursor something on the map

that has not been released. Once it is selected, then you right-click on it and again 'release clipping mask'.

If everything is released, by right-clicking you will not find anymore the tool 'release clipping mask'.

PS. you can do this only i) before modifying the image in PSD and ii) if it originally is a PDF image (or any 

kind of vector-based image).

A step-by-step tutorial is also available in the BSP Graphic Skills Portal – Adobe Illustrator handout

PPS. sometimes you need to 'ungroup' the image before starting realising clipping masks. To do this, right-

click on the image and press 'ungroup', then click on the grey background and, when everything is

deselected, start with the 'release clipping mask' process.

Combine a public realm plan with 3D
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Library

Theatre and

MuseumMuseum

URBAN PLAYGROUND

PUBLIC 
SQUARE

MID-BLOCK CROSSWALK 
AND GREENERY

Thurrock Theatre – 
façade renovation

Enlargement of the pedestrian 
and cycle lane + street trees 

New foyer and café spillover at 
the entrance of the theatre

Raised pavement to prioritise 
pedestrian footfall
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